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2: Static analysis of a plate 
Topics covered 

 Using the SOLIDWORKS Simulation interface 
 Linear static analysis with solid elements 
 Controlling discretization error with the convergence process 
 Finding reaction forces 
 Presenting FEA results in a desired format 

Project description 
A steel plate is supported and loaded, as shown in Figure 2-1. We assume that 
the support is rigid (this is also called built-in support, fixed support or fixed 
restraint) and that a 100000N tensile load is uniformly distributed along the end 
face, opposite to the supported face. 

 

Figure 2-1: SOLIDWORKS model of a rectangular plate with a hole. 

 

We will perform a displacement and stress analysis using meshes with different 
element sizes. Notice that repetitive analysis with different meshes does not 
represent standard practice in FEA. However, repetitive analysis with different 
meshes produces results which are useful in gaining more insight into how 
FEA works. 

100000N tensile load 
uniformly distributed 

Fixed restraint 



Engineering Analysis with SOLIDWORKS Simulation 2016 
 

32 

Procedure  
In SOLIDWORKS, open the model file called HOLLOW PLATE. Verify that 
SOLIDWORKS Simulation is selected in the Add-Ins list (Figure 2-2).  

 

 

Figure 2-2: Add-Ins list in SOLIDWORKS. 

Verify that SOLIDWORKS Simulation is selected in the list of Add-Ins.  

 

Once Simulation has been added, it shows in the main SOLIDWORKS menu 
and in the Command Manager.  

  

Select Simulation as 
an active Add-in and 
as a Start-up Add-in 
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Figure 2-3: The Simulation tab is a part of the SOLIDWORKS Command 
Manager. 

Selecting the Simulation tab in the Command Manager displays Simulation 
menu items (icons). Since no study has been yet created, only the Study 
creation icon is available; all others are grayed-out. For convenience, pin 
down the top tool bar as shown. Command Manager with Large Buttons is 
shown in this illustration. 

 

Notice that Feature Manager Design Tree shown in Figure 2-3 displays Solid 
Bodies and Surface Bodies folders. These folders can be displayed by right-
clicking anywhere in Feature Manager Design Tree to bring up the pop-up 
menu and selecting Hide/Show Tree Items. This will invoke System Options- 
Feature Manager (not shown here). From there, Solid Bodies and Surface 
Bodies folder can be selected to show.  We will need to distinguish between 
these two different bodies in later exercises. In this exercise these two folders 
do not need to show. 

Study creation 
button 

Pin down 

Simulation tab 

Right-click anywhere in 
the Feature Manager 

Design Tree. 
Select Hide/Show Tree 

Items 
 

Simulation 
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Before we create a study, let’s review the Simulation main menu (Figure 2-4) 
along with its Options window (Figure 2-5).  
 

 

 

Figure 2-4: Simulation main menu. 

Similar to the Simulation Command Manager shown in Figure 2-3, only the 
New Study icon is available. Notice that some commands are available both in 
the Command Manager and in the Simulation menu.  

 

Simulation studies can be executed entirely from the Simulation drop down 
menu shown in Figure 2-4. In this book we will use the Simulation main menu 
and/or Command Manager to create a new Study. Everything else will be done 
in the Study Property Manager window.  

Now click on the Simulation options shown in Figure 2-4 to open the 
Simulation System Options window shown in Figure 2-5.  

  

Simulation 
Options 

New Study 
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Figure 2-5: Simulation Options window. 

The Options window has two tabs.  In this example, Default Options and Units 
are selected and shown.  

 

Please spend time reviewing all of the options in both System Options and 
Default Options shown in Figure 2-5 before proceeding with the exercise. In 
the Units options, make the choices shown in Figure 2-5. In this book we will 
mostly use the SI system of units using MPa rather than Pa as a unit of stress 
and pressure. Occasionally we will switch to the IPS system. 

Notice that Default Plots can be added, modified, deleted or grouped into sub-
folders which are created by right-clicking on the results folders, for example, 
Static Study Results folder, Thermal Study Results folder, etc.   

Default Options 

Set Pressure/Stress unit to MPa 

Units 
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Creation of an FEA model starts with the definition of a study. To define a new 
study, select New Study in either the Simulation tab in the Command Manager 
(Figure 2.3) or Simulation main menu (Figure 2-4). This will open the Study 
Property Manager. Notice that the New Study icon in the Simulation 
Command Manager can be also used to open the Study Advisor. We won't be 
using the Study Advisor in this book. Name the study tensile load 01 (Figure 
2-6). 

 

 

Figure 2-6: Creating a new study. 

The study definition window offers choices for the type of study; here we select 
Static.   

Enter study name 

Select Static  

New Study button in the 
Simulation tab can be  

also used to open  
the Study Advisor 

Study Property 
Manager window  
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Once a new study has been created, Simulation Commands can be invoked in 
three ways:  

 From the Simulation Command Manager (Figure 2-3) 
 From the Simulation main menu (Figure 2-4) 
 By right-clicking appropriate items in the Study Property Manager 

window. In this book, we will most often use this method. 

When a study is defined, Simulation creates a study window located below the 
Feature Manager Design Tree and places several folders in it. It also adds a 
study tab located next to Model and Motion Study tabs. The tab provides 
access to the study (Figure 2-7). 

 

 
 
 
 

Figure 2-7: The Simulation window and Simulation tab. 

You can switch between the SOLIDWORKS Model, Motion Studies and 
Simulation Studies by selecting the appropriate tab. 

 

Simulation 
Study tab 

Simulation  
Study Window 

Motion 
Study tab 

SOLIDWORKS 
Model tab 
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We are now ready to define the analysis model. This process generally consists 
of the following steps: 

 CAD geometry idealization and/or simplification in preparation for 
analysis. This is usually done in SOLIDWORKS by creating an analysis 
specific configuration and making your changes there 

 Material properties assignment 
 Restraints application 
 Load application 

In this case, the geometry does not need any preparation because it is already 
very simple; therefore, we can start by assigning material properties.  

Notice that if a material is defined for a SOLIDWORKS part model, the 
material definition is automatically transferred to the Simulation model. 
Assigning a material to the SOLIDWORKS model is actually a preferred 
modeling technique, especially when working with an assembly consisting of 
parts with different materials. We will do this in later exercises.  

To apply material to the Simulation model, right-click the HOLLOW PLATE 
folder in the tensile load 01 simulation study and select Apply/Edit Material 
from the pop-up menu (Figure 2-8). 
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Figure 2-8: Assigning material properties.   

The top window shows the first step in the process of applying material 
properties to the model. 

The bottom window shows modification to System Options; this needs to be 
done only once. 

Select Apply/Edit Material 
to assign a material 

Deselect 
this options 
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The action in Figure 2-8 opens the Material window shown in Figure 2-9. 

 

 
 

Figure 2-9: Material window. 

Select Alloy Steel to be assigned to the model; select MPa as units. 

Click Apply, and then click Close. 

 

Alloy Steel 

  MPa 
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In the Material window, the properties are highlighted to indicate the 
mandatory and optional properties. A red color description (Elastic modulus, 
Poisson’s ratio) indicates a property that is mandatory based on the active study 
type and the material model. A blue color description (Mass density, Tensile 
strength, Compressive strength, Yield strength, Thermal expansion coefficient) 
indicates optional properties. A black color description (Thermal conductivity, 
Specific heat, Material damping ratio) indicates properties not applicable to the 
current study.   

In the Material window, open the SOLIDWORKS Materials menu, followed 
by the Steel menu. Select Alloy Steel. Select SI units under the Properties tab 
(other units could be used as well). Notice that the HOLLOW PLATE folder in 
the tensile load 01 study now shows a check mark and the name of the selected 
material to indicate that a material has been assigned. If needed, you can define 
your own material by selecting Custom Defined material. 

 

Defining a material consists of two steps: 

 Material selection (or material definition if a custom material is used) 
 Material assignment (either to all solids in the model, selected bodies of a 

multi-body part, or to selected components of an assembly) 
  

Having assigned the material, we now move to defining the restraints. To 
display the pop-up menu that lists the options available for defining restraints, 
right-click the Fixtures folder in the tensile load 01 study (Figure 2-10). 
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Figure 2-10: Pop-up menu for the Fixtures folder and Fixture definition 
window (Fixture Property Manager). 

All restraints’ definitions are done in the Type tab. The Split tab is used to 
define a split face where a restraint is to be defined. The same can be done in 
SOLIDWORKS by defining a Split Face.  

  

This window shows 
geometric entities 
where restraints are 
applied 

Split tab Type tab 

Right-click 
Fixtures and select 
Fixed geometry to 

open the Fixture 
Property Manager. 

 

Fixed 
Geometry  
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Once the Fixtures definition window is open, select the Fixed Geometry 
restraint type.  Select the end-face entity where the restraint is to be applied.  
Click the green check mark in the Fixture Property manager window to 
complete the restraint definition. 

Notice that in SOLIDWORKS Simulation, the term “Fixture” implies that the 
model is firmly “fixed” to the ground. However, aside from Fixed Geometry, 
which we have just used, all other types of fixtures restrain the model in certain 
directions while allowing movements in other directions. Therefore, the term 
“restraint” may better describe what happens when choices in the Fixture 
window are made. In this book we will switch between the terms “fixture” and 
“restraint” freely. 

The existence of restraints is indicated by symbols shown in Figure 2-10. In the 
Symbol Settings of the Fixture window, the size of the symbol can be changed. 
Notice that symbols shown in Figure 2-10 are distributed over the highlighted 
face meaning the entire face has been restrained. Each symbol consists of three 
orthogonal arrows symbolizing directions where translations have been 
restrained. Each arrow has a disk symbolizing that rotations have also been 
restrained. The symbol implies that all six degrees of freedom (three 
translations and three rotations) have been restrained. However, the element 
type we will use to mesh this model (second order solid tetrahedral element) 
has only translational degrees of freedom. Rotational degrees of freedom can't 
be restrained because they don't exist in this type of element. Therefore, disks 
symbolizing restrained rotations are irrelevant in our model.  Please see the 
following table for more explanations.  

Before proceeding, explore other types of restraints accessible through the 
Fixture window. Restraints can be divided into two groups: Standard and 
Advanced. Review animated examples available in the Fixture window and 
review the following table. Some less frequently used types of restraints are not 
listed here.
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Standard Fixtures 

Fixed Also called built-in or rigid support.  All translational and all 
rotational degrees of freedom are restrained. 

 
Immovable  
(No translations) 

Only translational degrees of freedom are restrained, while 
rotational degrees of freedom remain unrestrained. 
If solid elements are used (like in this exercise), Fixed and 
Immovable restraints would have the same effect because 
solid elements do not have rotational degrees of freedom. 
Therefore, the Immovable restraint is not available if solid 
elements are used alone. 

 
Roller/Slider 

Specifies that a planar face can move freely on its plane but 
not in the direction normal to its plane. The face can shrink or 
expand under loading.   

 
Fixed Hinge 

Applies only to cylindrical faces and specifies that the 
cylindrical face can only rotate about its own axis. This 
condition is identical to selecting the On cylindrical face 
restraint type and setting the radial and axial components to 
zero. 

Advanced Fixtures 

 
Symmetry 

Applies symmetry boundary conditions to a flat face. 
Translation in the direction normal to the face is restrained 
and rotations about the axes aligned with the face are 
restrained. 

 
Cyclic symmetry   

Allows analysis of a model with cyclic patterns around an 
axis by modeling a representative segment. The geometry, 
restraints, and loading conditions must be identical for all 
other segments making up the model. Turbine, fans, 
flywheels, and motor rotors can usually be analyzed using 
cyclic symmetry. 

 
Use Reference 
Geometry 

Restrains a face, edge, or vertex only in certain directions, 
while leaving the other directions free to move. You can 
specify the desired directions of restraint in relation to the 
selected reference plane or reference axis. 

 
On Flat Faces 

Provides restraints in selected directions, which are defined 
by the three directions of the flat face where restraints are 
being applied.   

On Cylindrical 
Faces 

This option is similar to On flat face, except that the three 
directions of a cylindrical face define the directions  
of restraints.  

On Spherical Face Similar to On Flat Faces and On Cylindrical Faces. The 
three directions of a spherical face define the directions  
of the applied restraints. 
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When a model is fully supported (as it is in our case), we say that the model 
does not have any rigid body motions (the term “rigid body modes” is also 
used), meaning it cannot move without experiencing deformation. 

Notice that the presence of restraints in the model is manifested by both the 
restraint symbols (showing on the restrained face) and by the automatically 
created icon, Fixture-1, in the Fixtures folder. The display of the restraint 
symbols can be turned on and off by either: 

 Right-clicking the Fixtures folder and selecting Hide All or Show All in 
the pop-up menu shown in Figure 2-10, or 

 Right-clicking the fixture icon and selecting Hide or Show from the pop-
up menu. 

Use the same method to control display of other Simulation symbols. 
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Now define the load by right-clicking the External Loads folder and selecting 
Force from the pop-up menu. This action opens the Force window as shown in 
Figure 2-11. 

 

 

Figure 2-11: Pop-up menu for the External Loads folder and Force window. 

The Force window displays the selected face where the tensile force is applied. 
If only one entity is selected, there is no distinction between Per Item and Total. 
In this illustration, load symbols have been enlarged by adjusting the Symbols 
Settings. Symbols of previously defined restraints have been hidden.  

This window shows 
geometric entities 
where loads are applied 

Right-click  
External Loads,  

select Force to open 
Force/Torque 

Property Manager 
Force 
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In the Type tab, select Normal in order to load the model with a 100000N 
tensile force uniformly distributed over the end face, as shown in Figure 2-11. 
Check the Reverse direction option to apply a tensile load.   

Generally, forces can be applied to faces, edges, and vertices using different 
methods, which are reviewed below: 

 

Force normal Available for flat faces only, this option applies load in 
the direction normal to the selected face. 

Force selected direction This option applies a force or a moment to a face,  
edge, or vertex in the direction defined by the selected 
reference geometry.   
Moments can be applied only if shell elements are used. 
Shell elements have six degrees of freedom per node: 
three translations and three rotations, and can take a 
moment load.  
Solid elements only have three degrees of freedom 
(translations) per node and, therefore, cannot take a 
moment load directly.  
If you need to apply moments to solid elements, they 
must be represented with appropriately applied forces. 

Torque This option applies torque (expressed by traction 
forces) about a reference axis using the right-hand rule. 

 

Try using the click-inside technique to rename the Fixture-1 and 
Force/Torque-1 items. Notice that renaming using the click-inside technique 
works on all items in SOLIDWORKS Simulation. 

The model is now ready for meshing. Before creating a mesh, let’s make a few 
observations about defining the geometry, material properties, loads and 
restraints. 

Geometry preparation is a well-defined step with few uncertainties. Geometry 
that is simplified for analysis can be compared with the original CAD model.  

Material properties are most often selected from the material library and do not 
account for local defects, surface conditions, etc. Therefore, the definition of 
material properties usually has more uncertainties than geometry preparation. 

The definition of loads is done in a few menu selections but involves many 
assumptions. Factors such as load magnitude and distribution are often only 
approximately known and must be assumed. Therefore, significant idealization 
errors can be made when defining loads.  
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Defining restraints is where severe errors are most often made. For example, it 
is easy enough to apply a fixed restraint without giving too much thought to the 
fact that a fixed restraint means a rigid support – a mathematical abstraction. A 
common error is over-constraining the model, which results in an overly stiff 
structure that underestimates displacements and stresses. The relative level of 
uncertainties in defining geometry, material, loads, and restraints is 
qualitatively shown in Figure 2-12. 

 

 
 
 

Figure 2-12: Qualitative comparison of uncertainty in defining geometry, 
material properties, loads, and restraints. 

 

The level of uncertainty (or the risk of error) has no relation to time required 
for each step, so the message in Figure 2-12 may be counterintuitive. In fact, 
preparing CAD geometry for FEA may take hours, while defining material 
properties and applying restraints and loads takes only a few clicks.  

Geometry Material Loads Restraints 



Engineering Analysis with SOLIDWORKS Simulation 2016 

 49 
 

In all of the examples presented in this book, we assume that definitions of 
material properties, loads, and restraints represent an acceptable idealization of 
real conditions. However, we need to point out that it is the responsibility of the 
FEA user to determine if all those idealized assumptions made during the 
creation of the mathematical model are indeed acceptable.   

Before meshing the model, we need to verify under the Default Options tab, in 
the Mesh properties, that High mesh quality is selected (Figure 2-13). The 
Options window can be opened from the SOLIDWORKS Simulation menu 
as shown in Figure 2-4.   

 

 

 

 

Figure 2-13: Mesh settings in the Options window. 

Use this window to verify that the mesh quality is set to High and the mesh type 
is set to Standard. Use these settings for other exercises unless indicated 
otherwise.  

 

Mesh quality set to High 
(second order elements used) 

Mesh type set to Standard 

Default Options 
 

Mesh 
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The difference between High and Draft mesh quality is: 

 Draft quality mesh uses first order elements 
 High quality mesh uses second order elements 

Differences between first and second order elements were discussed in chapter 
1. 

The difference between Curvature based mesh and Standard mesh will be 
explained in chapter 3. Now, right-click the Mesh folder to display the pop-up 
menu (Figure 2-14). 

 

 

 

Figure 2-14: Mesh pop-up menu. 

Select Create Mesh from the pop-up menu. 

 

In the pop-up menu, select Create Mesh. This opens the Mesh window (Figure 
2-15) which offers a choice of element size and element size tolerance.  

This exercise reinforces the impact of mesh size on results. Therefore, we will 
solve the same problem using three different meshes: coarse, medium (default), 
and fine.  Figure 2-15 shows the respective selection of meshing parameters to 
create the three meshes.  

 

Create Mesh 

Right-click  
Mesh to display  

mesh pop up menu 
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Figure 2-15: Three choices for mesh density from left to right: coarse, medium 
(default), and fine. 

Show Mesh Parameters to see the element size. In all three cases use Standard 
mesh. Notice the different slider positions in the three windows. Verify that 
standard mesh is used.  

 

The medium mesh density, shown in the middle window in Figure 2-15, is the 
default that SOLIDWORKS Simulation proposes for meshing our model. The 
element size of 5.72 mm and the element size tolerance of 0.286 mm are 
established automatically based on the geometric features of the 
SOLIDWORKS model. The 5.72 mm size is the characteristic element size in 
the mesh, as explained in Figure 2-16. The default tolerance is 5% of the global 
element size. If the distance between two nodes is smaller than this value, the 
nodes are merged unless otherwise specified by contact conditions; contact 
conditions are not present in this model. 

Mesh density has a direct impact on the accuracy of results. The smaller the 
elements, the lower the discretization error, but the meshing and solving time 
both take longer. In the majority of analyses with SOLIDWORKS Simulation, 
the default mesh settings produce meshes that provide acceptable discretization 
errors, while keeping solution times reasonably short. 

 

Coarse Default Fine 
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Figure 2-16: Characteristic element size for a tetrahedral element (left) and 
triangular element (right). 

The characteristic element size of a tetrahedral element is the diameter h of a 
circumscribed sphere (left). This is easier to illustrate with a 2D analogy of a 
circle circumscribed on a triangle (right). 

 

Right-click the Mesh folder again and select Create… to open the Mesh 
window. With the Mesh window open, set the slider all the way to the left (as 
illustrated in Figure 2-15, left) to create a coarse mesh, and click the green 
checkmark button. The mesh will be displayed as shown in Figure 2-17. 

 

 

Figure 2-17: A coarse mesh created with second order, solid tetrahedral 
elements. 

You can control the mesh visibility by selecting Hide Mesh or Show Mesh from 
the pop-up menu shown in Figure 2-14. 

Triangular element Tetrahedral element 
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The presence of a mesh is reflected in the appearance of the solid folder and the 
mesh folder in a Simulation study (Figure 2-18). 

 

 
 
 

Figure 2-18: Solid and mesh folders in a Simulation study before and after 
meshing. 

After meshing, cross hatching is added to the Solid folder and cross-hatching 
and a green check mark is added to the Mesh folder. 

 

To start the solution, right-click the tensile load 01 study folder which displays 
a pop-up menu (Figure 2-19). Select Run to start the solution. 

 

 

Figure 2-19: Pop-up menu for the tensile load 01 folder. 

Start the solution by right-clicking the tensile load 01 folder to display a pop-
up menu. Select Run to start the solution.  

Before meshing After meshing 

Run solution 
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The solution can be executed with different properties, which we will 
investigate in later chapters. You can monitor the solution progress while  
the solution is running (Figure 2-20).  

 

 

Figure 2-20: Solution Progress window. 

The solver reports solution progress while the solution is running.  

 

If the solution fails, the failure is reported as shown in Figure 2-21. 

 

 

Figure 2-21: Failed solution warning window. 

Here, the solution of a model with no restraints was attempted. Once the error 
message has been acknowledged (left), the solver displays the final outcome of 
the solution (right).   

 

When the solution completes successfully, Simulation creates a Results folder 
with result plots which are defined in Simulation Default Options as shown in 
Figure 2-5. 

In a typical configuration three plots are created automatically in the Static 
study; make sure that the above plots are defined in Simulation options, if not, 
define them: 

 Stress1   showing von Mises stresses 
 Displacement1 showing resultant displacements 
 Strain1  showing equivalent strain 
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Once the solution completes, you can add more plots to the Results folder. You 
can also create subfolders in the Results folder to group plots (Figure 2-22). 

 
 
 
 

Figure 2-22: More plots and folders can be added to the Results folder. 

Right-clicking on the Results folder activates this pop-up menu from which 
plots may be added.  

  

Three plots  
are automatically created  

if Results Options  
include these three plots 

Verify that Stresses and strains are 
selected in Results Options window  

Right-click  
to display  

Results Option  
window shown below 

Right-click  
Results folder 

 to invoke 
 pop-up window 

on the right 

You may define 
additional plots  
to be displayed 
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The Result Options window shown in Figure 2-22 has different choices 
depending on the type of study. In a Static study, deselecting Stress and strain 
disables calculation of stress and strain which reduces calculation time and the 
size of solution data base. This may be important in analysis of very large 
models. 

To display stress results, double-click on the Stress1 icon in the Results folder 
or right-click it and select Show from the pop-up menu. The stress plot is 
shown in Figure 2-23.  

 
Figure 2-23: Stress plot displayed using default stress plot settings.  

Von Mises stress results are shown by default in the stress plot window. Notice 
that results are shown in [MPa] as was set in the Default Options tab shown in 
Figure 2-5 and repeated here in the top illustration. The highest stress 340 
MPa is below the material yield strength, 620 MPa. The actual numerical 
results may differ slightly depending on the solver, software version, and 
service pack used. 

Pressure/Stress unit MPa 
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Once the stress plot is showing, right-click the stress plot icon to display the 
pop-up menu featuring different plot display options (Figure 2-24). 

 

 
 

Figure 2-24: Pop-up menu with plot display options. 

Plots can be modified using selections from the pop-up menu (top). Callouts 
relate selections in the pop-up menu to the invoked windows. Color Options 
selection in Chart Options is not shown. The same menus may by invoked by 
right-clicking on the color legend of result plots. 

  

Chart Options Definition Settings  

Right-click Results 
folder to display this 

menu 
Select: 

one of the following: 
Edit Definition 
Chart Options 

Settings 
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Explore all selections offered by these three windows shown in Figure 2-24. In 
particular, explore scientific, floating and general format options in Chart 
Options and color Options also in Chart Options. Notice that you may switch 
between Definition, Chart Options and Settings either by using the pop-up 
menu shown in Figure 2-24 or by using tabs at the top of these windows.  

Use Edit Definition to change units if necessary. Chart Options offers control 
over the format of numerical results, such as scientific, floating, and general, 
and also offers a different number of decimal places. Explore these choices. In 
this book, results will be presented using different choices most suitable for the 
desired plot. In many plots in this book Color Options will be User Defined to 
replace dark blue color with grey color which shows better in print. Figure 2-24 
shows the User Defined menu. Position of the color legend may be sometimes 
modified for improved layout. 

The default type of Fringe Options in the Settings window is Continuous 
(Figure 2-24). Change this to Discrete through the Default Options window, 
by selecting Plot (Figure 2-5). This way you won’t have to modify the future 
plots individually. In this book we will be using Discrete Fringe Options to 
display fringe plots.  The plots from the current study will not change after 
changing the default options. 

Since the above change does not affect already existing plots, we now examine 
how to modify the stress plot using the Settings window shown in Figure 2-25. 
In Settings, select Discrete in Fringe options and Mesh in Boundary options 
to produce the stress plot shown in Figure 2-25. 

 

Figure 2-25: The modified stress plot is shown with discrete fringes and the 
mesh superimposed on the stress plot.  
Numbers use floating format with one decimal place. 
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The stress plot in Figure 2-25 shows node values, also called averaged stresses. 
Element values (or non-averaged stresses) can be displayed by proper selection 
in the Stress Plot window in Advanced Options. Node values are most often 
used to present stress results. See chapter 3 and the glossary of terms in chapter 
23 for more information on node values and element values of stress results.  

 

Before you proceed, investigate this stress plot with other selections available 
in the windows shown in Figure 2-24.  

We now review the displacement and strain results. All of these plots are 
created and modified in the same way. Sample results are shown in Figure 2-26 
(displacement) and Figure 2-27 (strain). 
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Figure 2-26: Displacement plot (left) and Deformation plot (right). 

A Displacement plot can be turned into a Deformation plot by deselecting 
Show Colors in the Displacement Plot window. The same window has the 
option of showing the model with an exaggerated scale of deformation as 
shown above. Both plots have shown the deformed shape; this option may also 
be deselected. The blue color in the Displacement plot has been replaced with 
gray color for better appearance in this illustration. That was done in Chart 
Options, Color Options, User defined.  

 

Displacement plot 

Show colors selected Show colors deselected 

Deformed shape plot 
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Figure 2-27: Strain results. 

Strain results are shown here using Element values. The mesh is also shown. 

 

The plots in Figures 2-23, 2-25, 2-26, 2-27 all show the deformed shape in an 
exaggerated scale. You can change the display from deformed to undeformed 
or modify the scale of deformation in the Displacement Plot, Stress Plot, and 
Strain Plot windows, activated by right-clicking the plot icon, then selecting 
Edit Definition. 

Now, construct a Factor of Safety plot using the menu shown in Figure 2-22. 
The definition of the Factor of Safety plot requires three steps. Follow steps 1 
through 3 using the selection shown in Figure 2-28. Refer to chapter 1 and 
review Help to learn about failure criteria and their applicability to different 
materials. 
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Figure 2-28: Three windows show the three steps in the Factor of Safety plot 
definition. Select the Max von Mises Stress criterion in the first window.  

To move through steps, click on the right and left arrows located at the top of 
the Factor of Safety dialog. 

Step 1 selects the failure criterion, Step 2 selects display units, sets the stress 
limit and sets multiplication factor, Step 3 selects what will be displayed in the 
plot. Here we select areas below the factor of safety 3. 

  

Review Message and Help 
(question mark) to learn more 

about failure criteria 

Step 1 
Use von Mises Stress criterion. 
Review Property options to 
insert text and/or use specific 
views for the plot. 

Step 2 
Select multiplication factor. 

Step 3 
Select “Areas below a factor 
of safety” and enter the 
number 3. 

Click right arrow to move 
through windows 
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The factor of safety plot in Figure 2-29 shows the area where the factor of 
safety is below the specified. 

 

Figure 2-29: The red color displays the areas where the factor of safety falls 
below 3.  
Only two colors are used in this FOS plot.  

We have completed the analysis with a coarse mesh and now wish to see how a 
change in mesh density will affect the results. Therefore, we will repeat the 
analysis two more times using medium and fine density meshes respectively. 
We will use the settings shown in Figure 2-15. All three meshes used in this 
exercise (coarse, medium, and fine) are shown in Figure 2-30. 

 

 

Figure 2-30: Coarse, medium, and fine meshes. 

Three meshes used to study the effects of element size on results. 
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To compare the results produced by different meshes, we need more 
information than is available in the plots. Along with the maximum 
displacement and the maximum von Mises stress, for each study we  
need to know:  

 The number of nodes in the mesh. 
 The number of elements in the mesh. 
 The number of degrees of freedom in the model. 

The information on the number of nodes and number of elements can be found 
in Mesh Details accessible from the menu in Figure 2-14. The mesh Details 
window is shown in Figure 2-31.  

 

 

Figure 2-31: Mesh details window. 

Right-click the Mesh folder and select Details from the pop-up menu to display 
the Mesh Details window. Notice that information on the number of degrees of 
freedom is not available here. 
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Another way to find the number of nodes and elements and also the number of 
degrees of freedom is to use the pop-up menu shown in Figure 2-32. Right-
click the Results folder and select Solver Messages to display the window 
shown in Figure 2-32.  

 

 

Figure 2-32: The Solver Message window lists information pertaining to the 
solved study. 

Total solution time was too short to register. Click the Save button to save this 
solver message. 

 
Now create and run two more studies: tensile load 02 with the default element 
size (medium), and tensile load 03 with a fine element size, as shown in Figure 
2-15 and Figure 2-30. To create a new study we could just repeat the same 
steps as before but an easier way is to copy the original study. To copy a study, 
follow the steps in Figure 2-33.   
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Figure 2-33: A study can be copied into another study in three steps as shown. 

Notice that all definitions in a study (material, restraints, loads, mesh) can also 
be copied individually from one study to another by dragging and dropping 
them into a different study tab. 

 

A study is copied complete with results and plot definitions. Before remeshing 
with default element size, you must acknowledge the warning message shown 
in Figure 2-34. 

 

 

Figure 2-34: Remeshing deletes any existing results in the study. 

(1)  Right-click an existing study tab 

(2) 
Select duplicate 

(3) 
Enter new study name 
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The summary of results produced by the three studies is shown in Figure 2-35. 
 

Study  

 
Element size 

[mm] 
 

Number of 
nodes 

Number of 
elements 

Number of 
DOF 

Max. result. 
displ. 
[mm]  

Max. von 
Mises stress 

[MPa] 

tensile load 01 11.45 2779 1479 8166 0.117824 344 

tensile load 02  5.72 12208 7028 36069 0.118033 370 

tensile load 03 2.86 83769 54741 249903 0.118072 377 

 

Figure 2-35: Summary of results produced by the three meshes. 

Notice that these results are based on the same problem. Differences in the 
results arise from the different mesh densities used in studies tensile load 01, 
tensile load 02, and tensile load 03. 

The actual numbers in this table may vary slightly depending on the type of 
solver and release of the software used for solution.  

 

Figure 2-36 shows the maximum resultant displacement and the maximum von 
Mises stress as a function of the number of degrees of freedom. The number of 
degrees of freedom is in turn a function of mesh density. 
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Figure 2-36: Maximum resultant displacement (top) and maximum von Mises 
stress (bottom). 

Both are plotted as a function of the number of degrees of freedom in the model. 
The three points on the curves correspond to the three models solved. Straight 
lines connect the three points only to visually enhance the graphs. 

 

Having noticed that the maximum displacement increases with mesh 
refinement, we can conclude that the model becomes “softer” when smaller 
elements are used. With mesh refinement, a larger number of elements allows 
for better approximation of the real displacement and stress field. Therefore, 
we can say that the artificial restraints imposed by element definition become 
less imposing with mesh refinement. 

 

Max. resultant displacement 

Max. von Mises stress 

MPa 

mm 

# DOF 

# DOF 
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Displacements are the primary unknowns in structural FEA, and stresses are 
calculated based on displacement results. Therefore, stresses also increase with 
mesh refinement. If we continued with mesh refinement, we would see that 
both the displacement and stress results converge to a finite value which is the 
solution of the mathematical model. Differences between the solution of the 
FEA model and the mathematical model are due to discretization errors, which 
diminish with mesh refinement. 

We will now repeat our analysis of the HOLLOW PLATE by using prescribed 
displacements in place of a load. Rather than loading it with a 100000N force 
that caused a 0.118 mm displacement of the loaded face, we will apply a 
prescribed displacement of 0.118 mm to this face to see what stresses this 
causes. For this exercise, we will use only one mesh with the default (medium) 
mesh density. 

Define a fourth study, called prescribed displ. The easiest way to do this  
is to copy one of the already completed studies, for example study tensile load 
02. The definition of material properties, the fixed restraint to the left-side end-
face and mesh are all identical to the previous design study. We need to delete 
the current External Loads (right-click the load icon and select Delete) and 
apply in its place a prescribed displacement.  

To apply the prescribed displacement to the right-side end-face, right-click the 
Fixtures folder and select Advanced Fixtures from the pop-up menu. This 
opens the Fixture definition window. Select On Flat Face from the Advanced 
menu and define the displacement as shown in Figure 2-37. Check Reverse 
direction to obtain displacement in the tensile direction. Notice that the 
direction of a prescribed displacement is indicated by a restraint symbol. 

Prescribed displacement may also be defined from the External Loads folder 
by selecting Prescribed Displacement from the pop-up menu. This opens the 
same Fixture definition window. Figure 2-37 illustrates both methods of 
defining prescribed displacement.  
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Figure 2-37: Two methods of defining prescribed displacement.  

The prescribed displacement of 0.118 mm is applied to the same face where the 
tensile load of 100000N had been applied. Select Reverse Direction and verify 
that the arrows are pointed away from the selected face. 

 

Once again, notice that the visibility of all loads and restraints symbols is 
controlled by right-clicking the symbol and making the desired choice 
(Hide/Show).  All load symbols and all restraint (fixture) symbols may also be 
turned on/off all at once by right-clicking the Fixtures or External loads 
folders and selecting Hide all/ Show all from the pop-up menu.     

Prescribed displacement 
0.118mm 
Reverse direction selected Previously 

defined Fixed 
restraint 

Method 1 
Using Fixture folder 

Method 2 
Using External loads folder 
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Once a prescribed displacement is defined to the end face, it overrides any 
previously applied loads to the same end face. While it is better to delete  
the load in order to keep the model clean, the load has no effect if a prescribed 
displacement is applied to the same entity in the same direction. 

Figure 2-38 compares stress results for the model loaded with force to the 
model loaded with prescribed displacement.  

 

 
 

Figure 2-38: Comparison of von Mises stress results. 

Von Mises stress results with a load applied as a force (top) and von Mises 
stress results with a load applied as a prescribed displacement (bottom). 

Study: tensile load 02 

Study: prescribed displacement 
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Results produced by applying a force load and by applying a prescribed 
displacement load are very similar but not identical. The reason for this 
discrepancy is that in the model loaded by force, the loaded face does not 
remain flat. In the prescribed displacement model, this face remains flat, even 
though it experiences displacement as a whole. Also, while the prescribed 
displacement of 0.118 mm applies to the entire face in the prescribed 
displacement model, it is only seen as a maximum displacement in one  
point in the force load model. You may plot the displacement along the edge of 
the end face in study tensile load 02 by following the steps in Figure 2-39. 
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Figure 2-39: Plotting displacement along the edge of the force loaded face in 
study tensile load 02. 

Right click the resultant displacement plot in the tensile load 02 study to invoke 
a pop-up menu shown in the top left corner. Follow steps 1 through 4 to 
produce a graph of displacements along the loaded edge. Repeat this exercise 
for a model loaded with a prescribed displacement to verify that the 
displacement is constant along the edge. 

(1) 
Right-click the 

Displacement plot and 
select List selected to 

open the Probe 
Result window  

(3) 
Click Update 

(2) Select the edge where you wish to 
plot displacements. This opens the Probe 
Result window 

(4)  Click Plot 



Engineering Analysis with SOLIDWORKS Simulation 2016 
 

74 

We conclude the analysis of the HOLLOW PLATE by examining the reaction 
forces using the results of study tensile load 02. In the study tensile load 02, 
right-click the Results folder. From the pop-up menu, select List Result Force 
to open the Result Force window. Select the face where the fixed restraint is 
applied and click the Update button. Information on reaction forces will be 
displayed as shown in Figure 2-40.  
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Figure 2-40: Result Force window. 

Right-click the Results folder and follow steps 1 through 4 to analyze and 
display reaction forces. Reaction forces can also be displayed in components 
other than those defined by the global reference system. To do this, reference 
geometry such as a plane or axis must be selected.  

(2) 
Selected face where Fixed 

Restraint is applied 

(4) 
Click Update 

(5) 
Review reaction 
forces in the Result 
Force window and in 
the model display  

If desired, reference 
geometry can be 
selected to define 
directions of reaction 
components 

(1) 
Right-click the Results 

folder and select 
List Result Force to 

open the Result Force 
window 

If Display resultant 
forces is selected then 
one resultant force is 
displayed. Otherwise 
reaction components 
are displayed as shown 
here.   

(3) 
Select 
Reaction force 
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A note on where Simulation results are stored: By default, all study files are 
saved in the same folder with the SOLIDWORKS part or assembly model. 
Mesh data and results of each study are stored separately in *.CWR files. For 
example, the mesh and results of study tensile load 02 have been stored in the 
file HOLLOW PLATE-tensile load 02.CWR 
 

When the study is opened, the CWR file is extracted into a number of different 
files depending on the type of study.  Upon exiting SOLIDWORKS 
Simulation (which is done by means of deselecting SOLIDWORKS 
Simulation from the list of add-ins, or by closing the SOLIDWORKS model), 
all files are compressed allowing for convenient backup of SOLIDWORKS 
Simulation results.  

The location of CWR files is specified in the Default Options window (Figure 
2-5). For easy reference, the Default Options window is shown again in Figure 
2-41. 

The size of CWR file may be significantly reduced if stresses and strains are 
deselected in the Results Options (Figure 2-22). We will work with simple 
models; therefore, we won’t use this option. 
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Figure 2-41: Location of solution database files. 

You may use the SOLIDWORKS document folder or a user defined folder as 
shown above. 

 

Using the settings shown in Figure 2-41, *.CWR files are located in folder 
F:\FEA results. The default location is the SOLIDWORKS document folder.  

Results 

Location of result files 

Default Options 
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Models in this chapter 
 

 
Model 
 

 
Configuration 

 
Study Name 

 
Study Type 
 

 
 
HOLLOW PLATE.sldprt 

 
 
Default 

tensile load 01 Static 

tensile load 02  Static 

tensile load 03 Static 

prescribed displ Static 

 
 

 
 

   
  




